6 OTHER DATA TYPES (WHEN YOU ARE NOT JUST DEALING WITH NUMBERS) ........................................................................................................43

6.1 Getting Friendly with Strings .................................................................................................................................................. 43
6.2 Interconverting Strings and Numbers ................................................................................................................................. 44
6.3 Structures and Cell Arrays ...................................................................................................................................................... 45
6.4 Parsing data and text in figures............................................................................................................................................ 49
1 Before we get started

1.1 Goals and Logistics
This is meant to be either a guide during a MATLAB course or a stand alone introductory packet. The goal of this course/packet is to get someone who has never programmed before to be able to read and write simple programs in 6-8 hours and slightly more extensive programs in double that time.

Instructions you should type into MATLAB are displayed in red courier font. You can cut and paste commands in this packet directly into MATLAB.

Output that you will see from MATLAB is shown in black courier font. The output won't always be included in this document.

Download the accompanying zip file as that contains useful examples and materials that are used in this packet. Materials can be downloaded from the following website: http://www.hms.harvard.edu/bss/neuro/bornlab/qmbc/

1.2 Mantra
The goal is not to get through the packet as quickly as possible. Think about the commands you type in and make sure you understand the output. If you have a question, explore and try things out; it’s a great way to learn. It is hard to break a computer.

1.3 MATLAB Help
In this is part of the course ask us any time you need help; otherwise …
There are many ways to access MATLAB help, some of which will be highlighted in the packet.

- If you know the name of the command, type help <command> at the MATLAB command prompt for a quick refresher. To get more detailed information, including related commands, type doc <command> to open up the help browser.
- If you don't know the name of the command, you can type lookfor <keywords> to get a list of commands that have <keywords> in their description.
- Finally like most other programs, there is a help menu in the command bar at the top of the screen. Clicking “Product Help” will open the MATLAB documentation browser. The same materials are also online at http://www.mathworks.com/access/helpdesk/help/techdoc/matlab.html.
2 What you see when you open MATLAB

There are three subsections of this window:

The right subwindow is the command window. You will type all your commands into MATLAB here.

The bottom left corner is the command history. Any time you enter a command into MATLAB it records the command you entered. The time and date that you log in is also recorded. This is a useful way to repeat or view what you did on an earlier date. You can copy and paste this into a different file, or double click a command to repeat it.

The top left corner is the current directory. It tells you your current directory in the file structure of the computer. This becomes important when you write programs that you will run later. Alternatively if the workspace tab is highlighted, the top left will display all the variables that you have made and will indicate their current sizes and values.

Often you will store all your files in one directory on your computer. You can change the directory you are in using the buttons just above the command window. We will demonstrate this later.
3 Variables, Arrays & Functions

3.1 Variables

Let's start by using Matlab like a calculator; type

```
>> 2+3
```

into the command window (rectangle). Note that the chevrons (>>) indicate that matlab is ready for your input.

You will see that

```
ans = 5
```

appears on the screen. In the bottom left screen, the line you typed in appears. In the top left screen the variable `ans` appears (as shown below).

Note: Your window may look different depending on the version of MATLAB you are running. You can go to the desktop menu to change this layout.

```
>> x=3;
```

This stores the value 3 into the variable `x`.

How MATLAB evaluates this code:
MATLAB first evaluates everything to the right of the equal sign. Then it stores, or assigns, the result in the variable on the left side of the equals sign. This is why `=` is technically called the assignment operator. If there is no equal sign, MATLAB simply prints the result of the evaluation.

```
>> y=2
```
\[ y = 2 \]

Notice the difference of including the ";". A ";" suppresses the output of the line. You will almost always want to end your lines with semicolons. For most of this tutorial, the ";" will not be included so you can see the output for instructional purposes.

\[
\begin{align*}
&\text{\hl{\lstinputlisting[language=Matlab,firstnumber=1-step=-1]{example_code.txt}}}
\end{align*}
\]

In class example: order of operation.
1.
\[
\begin{align*}
\gg &\quad x=3; \\
\gg &\quad x=x+1;
\end{align*}
\]

2.
\[
\begin{align*}
\gg &\quad x=3; \\
\gg &\quad x=(x+1)^2
\end{align*}
\]

3.
\[
\begin{align*}
\gg &\quad x=3; \\
\gg &\quad x=(x+1)^2/2
\end{align*}
\]

You can see the variable \( x \) change in value in the workspace.

Quick exercise:

\textit{Without using MATLAB, determine the result of the following code:}

\[
\begin{align*}
\gg &\quad x=3; \\
\gg &\quad y=x-2; \\
\gg &\quad x=(x-y*2)^2+1
\end{align*}
\]

\begin{align*}
A: &\quad 17 \\
B: &\quad 64 \\
C: &\quad 1 \\
D: &\quad 2
\end{align*}

Quick exercise:

\textit{Use MATLAB to perform the following operations:}

Store the sum of 1 and 3 in \( x \).
Make \( y \) equal to \( 3\times x \).
Calculate and store the average of \( x \) and \( y \) in \( z \).
What is \( z \) equal to?

3.2 Arrays

What does experimental data look like? Experimental data are often things like images, time courses, microarrays, dose responses, etc. For example, a sequence of numbers can be stored as a one-dimensional array (also known as a \textit{vector}), and a black-and-white
image can be stored as a 2-dimensional array of pixel intensities. In fact, almost any kind of data can be stored as an array of some dimension.

If you’re analyzing experimental data on a computer, it is incredibly useful to be able to store them as arrays and perform math on them. For example, if we wanted to take the sine of a large number of values, we can store all these values in an array and take the sine of every entry with a single command. In MATLAB, just as in Excel, individual elements or whole rows or columns can be easily extracted, plotted, or changed. Due to its ability to efficiently work with large matrices, MATLAB actually stands for MATrix LABoratory.

**Loading arrays into MATLAB**

There are two basic ways of loading arrays into MATLAB:

1. **Drag-and-drop.** Many pieces of data can be loaded into MATLAB simply by dragging them into the command window. This opens the “user interactive open (uiopen)”. Try this. Drag a jpg image into MATLAB and see what happens.

2. **Cut and Paste.** If you have a file open in a program like Excel you can copy the data and paste it into an array. For example start by declaring a new variable:

   ```
   >> x=[];
   ```

   This creates an array named x which doesn’t have any values assigned to it. You can now open this array with the interactive editor by double clicking the variable x in the workspace window. You can now go to excel, copy the info, come back to MATLAB, and paste.

**Visualizing an array**

Drag “sophie2.jpg” into the command window.

```
>> figure
```

This creates a new “window” which MATLAB can draw graphics in.

```
>>
```

How did this display our image – how are numbers converted into the picture?

```
>> colorbar
```

Does this confirm you intuition?

```
>> imagesc(sophie2);
>> colorbar
```

What’s the difference between **imshow** and **imagesc**?

```
>> figure
>> mesh(double(sophie2));
>> colorbar
```
Uncluttering the workspace

As we proceed it is sometimes useful to get rid of all the variables in the workspace, close all the figure, etc.

Here are some useful commands:

\[ \text{>> clc} \]
Clears the command window

\[ \text{>> clear} \]
Clear all the workspace

\[ \text{>> close all} \]
Close all figures

Retrieving values from an array

It is easiest to start by thinking of how to retrieve values from pre-existing arrays. There are two pieces of information that the computer will need to retrieve a value from an array. It will need the name of the array and the position from which you want to retrieve the values.

\[ \text{>> LoadArray} \]

You have just run your first “script” or program. This command called a program (LoadArray), which we wrote to enter an array called \text{MyArray}. Look in the workspace and you will see the new array.

How big is the array (how many rows, how many columns)?

Double-click the array \text{MyArray} in the workspace. The array and all its values now appears in a table above the command window. You can close this window by clicking on the x in the top right corner.

\[ \text{>> MyArray(1,2)} \]

This returns the element that is in the first row, second column of the array \text{MyArray}. Note that MATLAB counts rows from top to bottom and columns from left to right.

In general, \text{MyArray(m,n)} retrieves the value in the m-th row, n-th column. Here m and n are the “indexes” of the array element because they tell us its location. This is why retrieving an array element is sometimes called \text{indexing}.

Guess what these commands will return before typing them in:
>> MyArray(4,3)

>> MyArray(4,4)

>> MyArray(4;3)

What happens when you type in the last command above? Why?

Quick Exercise
Retrieve the value 8 from MyArray.

Answer: MyArray(2,3)

>> MyArray(3)
What did this do? Why?

What will this retrieve?
>> MyArray(7)

When indexing by a single number, does Matlab “stack” rows or columns? In other words, does MATLAB count through the elements in an array by columns or by rows?

Quick Exercise
Retrieve the value 8 from the MyArray using the single number position format.

Answer: MyArray(10)

Manipulating Arrays
You can copy whole arrays
>> a=MyArray

You can also manipulate entries in arrays one at a time.

>> a(1,2)=100

a =

1   100   5
6    7   8
-1   50   0
4    5   2

>> a(1,2)=a(1,2)+1

a =
Element retrieval and manipulation can be performed in one line.

This line took the value from the first row, second column of \( a \), added 1 to this value, and then stored it back in array \( a \) in the first row, second column.

\[
\begin{bmatrix}
1 & 101 & 5 \\
6 & 7 & 8 \\
-1 & 50 & 0 \\
4 & 5 & 2 \\
\end{bmatrix}
\]

\[
\begin{align*}
>> & \ a(4,1)=a(4,1)+1 \\
>> & \ a(1,4)=a(1,4)+1
\end{align*}
\]

You receive an error message because there is no fourth column.

Errors messages in MATLAB are useful. Don’t Panic! Take time to read them. They will often let you quickly correct your error.

**Altering the array with the interactive editor**

Double click on “\( a \)” in the workspace. A new tab will open in the array editor and array \( a \) should appear. Now just try replacing the value 0 with -20 just as you would in Excel.

Now add the number 3 in position (6,2). What happened?
Now add the number 3 in position (7,5). What happened?
\[
>> \ a(8,9)=4;
\]
How is this similar or different?

**What do you think the following will do?**
\[
>> \ a(2,3,2)=4;
\]

**How big is my array**

It is often useful to be able to figure out the size of an array. The following two commands are very useful:
\[
\begin{align*}
>> & \ size(a) \\
>> & \ length(a)
\end{align*}
\]
What did these do?

**Quick Exercise – clicker II**

Starting with the current array. If we typed:
\[
>> \ a(2,3,10)=4;
\]
What would we get if we typed
1. \( \text{size}(a) \)
   a. 2 3 10
   b. 10 3 2
c. 8 9 10
d. 10 9 8

2. \text{length(a)}
   \begin{itemize}
   \item[a.] 10
   \item[b.] 9
   \item[c.] 8
   \item[d.] 27
   \end{itemize}

3. \text{a(1,1,8)}
   \begin{itemize}
   \item[a.] 4
   \item[b.] 0
   \item[c.] impossible to know
   \item[d.] error message(“position does not exist”)
   \end{itemize}

\textbf{Nested inputs}

\begin{verbatim}
>> LoadArray
>> b=MyArray2;
\end{verbatim}

What is \texttt{b(3)}?
What is \texttt{b(b(3))}?
What is \texttt{b(b(b(3)))}?
What is \texttt{b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(3)))))))))))))))))))))}? \\

\textbf{Quick Exercise – Thought exercise – clicker III}

What is \texttt{b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(b(2))))))))))))))))))))))))))))))}}? \\

\begin{itemize}
\item[a.] 2
\item[b.] 3
\item[c.] 4
\item[d.] either 2 or 4 but I'm too lazy to figure out
\end{itemize}

\textbf{Preview: Built-in functions, plotting, histograms, data analysis}

Just for fun, try typing in the following commands and see what they do. They will be explained in more detail in the sections below.

\begin{verbatim}
>> MysteryArray=rand(1000,1);
\end{verbatim}

What happened? What would be good ways to explore this?

How many numbers? Columns versus rows?
\begin{verbatim}
>> length(MysteryArray)
>> size(MysteryArray)
\end{verbatim}

What is the smallest value; what is the largest?
\begin{verbatim}
>> min(MysteryArray)
>> max(MysteryArray)
\end{verbatim}

What is the average, standard deviation?
\begin{verbatim}
>> mean(MysteryArray)
>> std(MysteryArray)
\end{verbatim}
What does the distribution look like?

```matlab
>> figure
% this creates a figure
>> plot(MysteryArray,'.'), % the second input here indicates
% the type of marker
% this says to plot red '+'
>> plot(sort(MysteryArray),'.')
>> figure, hist(MysteryArray)
% this creates a figure and makes a
% histogram. The comma tells MATLAB
to run the first command, and then
the second.
```

```matlab
>> MysteryArray=rand(10);
What did this do?
>> MysteryArray=rand(10,5);
What did this do?
>> max(MysteryArray)
What did this do?
>> mean(MysteryArray)
What did this do?
How can we get the mean of the whole array?
>> MysteryArray(:)
What did this do?
```

**Quick exercise:**

1. Figure out what the `randn` function does.
2. Create a random number normally spaced with a standard deviation of 3 and a mean of 10. Convince yourself you got it right.

**Class discussion:**

How would we create integers evenly spaced between 1 and 10?

**Defining a complete array**

For the purposes of our exercises, let's define an array `a`.

```matlab
>> a=[1 2] % Notice we have square bracket now.
a =
     1     2
```

[] - Square bracket mean make everything inside into an array.
() – Has a variety of uses. Evaluate what’s inside first. Search for this position in an
array. Send information to a function.
{} – Means make a cell array (we will get to this later).

Adding elements to a pre-existing array

```
>> a=[a 3]
 a =
 1 2 3
```
This adds a 3 to the end of the array.

Column versus row vectors

`a` is a row vector – an array with one row and several columns. In some cases, we will want to work with column vector. In this context, a semi-colon indicates the start of a new row.

```
>> a=[1;2;3]
 a =
 1
 2
 3
```
This creates a column array with one column and 3 rows.

When defining an array,
, or ‘ ‘ – comma or space – means move to the right
; - semicolon mean start a new line (like return/enter when typing)
, - comma as is used as a delimiter. You have already seen `a(2,3)` for example where the comma delimits the dimension.

To change a row vector to a column vector or vise versa, you can use the transpose operator '.

```
>> a'
 ans =
 1 2 3
```

```
>> a=[a 4]
```
This doesn't work! Right now `a` is a 3 row x 1 column array, so we can't add another column with only 1 entry.

```
>> a=[a; 4]
```
This works, now `a` is a 4 row x 1 column array.

Mathematical manipulation of an array

```
>> a*2
```
ans =
  2
  4
  6
  8

Note the 2* applies to every element of the column vector.
>> a=[a a*2]

a =
    1     2
    2     4
    3     6
    4     8

This works too! Matrix elements can be inserted and manipulated at the same time.

>> a=a+1

a =
    2     3
    3     5
    4     7
    5     9

This applies to every member of the array. Division by a constant (/) and subtraction of a constant (-) also work.

>> x=2;
>> a*x

This multiplies every element of the array by the scalar \( x \).

When an array is multiplied or divided by, or added or subtracted to a scalar (a single number), each element in the array is manipulated in the same way.

**Arrays and values are interchangeable**

>> a([1 2],1)=a(2,2)

This replaces the first and second row of the first column with the value in \( a(2,2) \).

This is the real power of MATLAB. You can use values, an array, or even a function (which will hopefully return an array or value) interchangeably. MATLAB handles it correctly.

>> a(:,2)=0

This replaces every row in the second column with zeros.

Here the colon denotes all the rows in \( a \). \( a(:,2) \) is equivalent to \( a([1 2 3 4], 2) \).

When you define an array you use \([\]\); when you call a position in an array you use \((\)\).

**Matrix manipulation continued**

>> a=[1 2; 3 4]
>> b=[2 4; 3 3]
>> c=a+b

This adds the elements of the matrices that are in identical positions, which is called an element-wise operation. This will only work if the dimensions of \( a \) and \( b \) match – they have the same number of rows and columns. This is equivalent to the more laborious:

\[
\begin{align*}
c(1,1) &= a(1,1) + b(1,1) \\
c(1,2) &= a(1,2) + b(1,2) \\
c(2,1) &= a(2,1) + b(2,1) \\
c(2,2) &= a(2,2) + b(2,2)
\end{align*}
\]

Addition and subtraction are always element-wise operations. However, division, multiplication and exponentiation (\(^\)\) are not. This is because there are special definitions for these operations with matrices (linear algebra). However, to perform element-wise operations, such as multiplication, you can use the dot operator.

>> c=a.*b
ans =
    1     4
    9    16

This multiples each element of the array \( a \) by the equivalent element in array \( b \), or:

\[
\begin{align*}
c(1,1) &= a(1,1) \times b(1,1) \\
c(1,2) &= a(1,2) \times b(1,2) \\
c(2,1) &= a(2,1) \times b(2,1) \\
c(2,2) &= a(2,2) \times b(2,2)
\end{align*}
\]

In contrast, when we multiply two matrices together using ‘\(^\)\)' without the preceding dot, we carry out matrix multiplication, a special operation in linear algebra.

>> a*a
ans =
    7    10
   15    22

This performed the matrix multiplication of \( a \) by \( a \).

**Entering arrays**

There are many ways to enter arrays into MATLAB. When you have just a few data points it is pretty easy to just type them in. Things become much more complicated when there is lots of data.

Often you will have the data in another format and want to open in MATLAB. There are ways to do this, which we will go into later.
Method 1: Type it all in

```matlab
>> t=[0 1 2 3 4 5 6 7 8 9]
```
This creates a variable `t`, which is a one-dimensional array (or a row vector), with 10 entries.

Method 2: The colon operator

Let's figure out how this works through exploring. Try out the following commands. Talk with your neighbor.

```matlab
>> figure,imshow(sophie2)
>> figure,imshow(sophie2(100:1:150,175:1:270))
>> figure,imshow(sophie2(150:-1:100,175:1:270))
>> figure,imshow(sophie2(1:1:end,end:-1:1))
>> figure,imshow(sophie2(1:2:end,1:2:end))
>> figure,imshow(sophie2(1:4:end,1:4:end))
>> figure,imshow(sophie2(1:8:end,1:8:end))
>> figure,imshow(sophie2(1:end-20,:))
```

One can enter the array `t` above much more easily by using the colon notation:

```matlab
>> t=[0:1:9]
```

```
0 1 2 3 4 5 6 7 8 9
```

This means make an array starting at 0 stopping when less than or equal to 9 and stepping by 1.

In general, `a:x:b` means start at `a`, and step by `x` until `b` is reached (`x` can be negative). The default step size is 1, so `[0:1:9]` is the same as `[0:9]`. If `x` is positive, the number will get bigger. If `x` is negative, it will get smaller.

More explicitly, let's take the example:

```matlab
c = [1.1:2.3:6.8]
```

Here `x' = 2.3, which is greater than 0, so the series will increase. To compute `c`:

1. Start with `a` and check to see if that is less than or equal to `b`. Since 1.1 < 6.8, `c(1) = 1.1`. If `a > b`, the computation of `c` is complete.
2. Add `x` to `a`. In this example this results in 1.1 + 2.3 = 3.4. We will call 3.4 the new 'a'.
3. Return to Step 1.

In this example

`c(2) = 3.4`
c(3) = 5.7
5.7 + 2.3 = 8 > 6.8, so the computation of c is complete.

\[ c = [1.1 \ 3.4 \ 5.7] \]

If \( c = [-1.1 : -2.3 : -6.8] \), the calculation is analogous, except in step 1, the computation finishes when \( a < b \). So this will return \( c = [-1.1, -3.4, -5.7] \)

\[ \text{>> t} = 0:9 \]
If no step size is listed, MATLAB assumes the step size is 1.
Note: the colon operator automatically creates an array – the [] brackets are optional.

\[ \text{>> t} = 0:0.5:2.75 \]
\[ \text{>> t} = 8:1 \]
\[ \text{>> t} = 8:-1:1 \]

Try your own, and make sure you understand this.

You can also use the colon operator to extract elements from an array. For example, if you have a vector \( t \) with time points from an experiment and only want to look at every third time point, you can type \( t(1:3:end) \) and you will see every third entry of \( t \).

Quick exercise: (these are tough and might need some trial and error)
1. How many ways can you think of to define the following array: 2 4 6
2. What will this return: \( 1:5+1 \)
3. \( A=[]; A(end+1)=3; A(end+1)=5; \) What is the resultant vector? why?

3.3 Logical Operators Applied to Arrays
A brief aside – logical operators can also be applied to arrays. Define an array
\[ \text{>> m} = [0:2:20] \]

Now type
\[ \text{>> m2 = m > 10} \]

This returns an array of the same length as \( m \), where \( m2(y) = m(y) > 10 \). In other words, each element of \( m \) is subjected to the logical test, and the result is recorded in \( m2 \). As is the usual convention, 1 is stands for TRUE and 0 stands for FALSE.

A variation on this technique is to type:
\[ \text{>> m2 = m(m > 10)} \]
In this case \( m_2 \) only contains the values of \( m \) which are greater than 10. MATLAB computes the logical vector \( m > 10 \), and when this is used to extract elements of \( m \), only the elements which correspond to 'true' entries are returned.

The final variation is:

\[
>> m2 = \text{find}(m > 10)
\]

Instead of returning the values of \( m \) that are greater than 10, the 'find' command returns the indices of the elements of \( m \) that are greater than 10.

Other use logical operators:

- == checks if 2 things are equal
- < checks if the value on the left is less than the value on the right
- <= less than or equal
- ~= not equal

The \text{find} command and logical operators are extremely useful! Imagine you have two vectors \( x \) and \( t \). \( x \) has data points from a time series experiment and \( t \) has the times of each time point. Imagine you want to find the times when \( x > 0 \). You can type \( t(x>0) \) or \( t(\text{find}(x>0)) \) to do this. To find out how many data point are greater than 0, you can type \text{sum}(x>0) or \text{length}(\text{find}(x>0)). The \text{find} command works a bit differently with arrays than vectors. Be sure to type \text{help find} to learn more!

Quick exercise:
Replace the values of \( m \) that are less than 10 with 0.

3.4 Exercise 1: Putting It Together

Before you start the exercise clear the workspace, close all windows, and clear the command window. Look back through the packet if you need a refresh of different commands.

1. Load sophie2.jpg.
   a. Display the image
   b. Calculate the minimum value of the image
   c. Calculate the maximum value of the image
   Create a new version of sophie2 where:
   d. The 20 columns on the left and right edge of the image are equal to the minimum of the image.
   e. The 20 rows on the top and bottom of the image are equal to the maximum of the image.
   f. Can you do d and e in one line of code each?!?
2. Store Sophie’s face in a new array. In one line of code, create a new array containing:
a. Two copies of Sophie's face side by side
b. Two copies of Sophie's face one on top of the other

3. Load sophie2.jpg.
   a. Copy Sophie's face (rows 100 to 150 and columns 175 to 270) to the same row and column positions but in the 3rd plane of the 3rd dimension of Sophie. What is the minimum value of the 3rd plane of the 3rd dimension?
   b. What is the value in every position in the 2nd plane of the 3rd dimension?
   c. Make Sophie's face in the 1st plane of the 3rd dimension equal to zero. Look at the image with imshow. What happened?
   d. How do you think you could make Sophie's face green?

4. It's SNOWING! How recognizable is Sophie when you start adding noise? In order to do this exercise you will need to start by converting the sophie2 image into an image on which we can do math (we will discuss this more later).
   a. Convert sophie2 to a matrix of double-precision numbers by typing double(sophie2) and store the result to a new variable sophie3.
   b. Make a matrix the same size as sophie3 but containing uniformly distributed random numbers between 0 and 10. Add this noise to sophie3 and store the result to a new variable.
   c. Visualize the noisy image with the imshow command. Make sure to include [] (empty square brackets) as a second parameter; this tells imshow to auto-scale the image. How does the image look?
   d. Try varying both the magnitude and range of the noise (i.e. random numbers between 0 and 100, or 50 and 100). How does the image look? Does it get brighter overall or dimmer? Why?
   e. Try adding normally distributed noise instead of uniform noise. Are the results any different?
3.5 Built-In MATLAB Functions
MATLAB has many built in functions that are useful for calculations.

\[
\text{\texttt{sin(2*pi)}}
\]

Functions can be performed on variables as well as on numbers.

\[
\begin{align*}
\text{\texttt{t=2*pi;}} \\
\text{\texttt{g=sin(t)}}
\end{align*}
\]

Function call are always of the form
\[
\text{\texttt{NAME_OF_FUNCTION(VALUE_TO_PERFORM_FUNCTION_ON)}}
\]

Like variables, functions are an incredible useful organizational tool, and we will come back to them repeatedly.

There are a bunch of useful built in functions in MATLAB. You can often guess at the name (for example \texttt{mean} calculates the mean; \texttt{median} finds the median). This short list is meant to give you a feeling for how the functions work.

To see if a function exists, type the first couple letters and press 'tab'. A list of functions that have names starting with those letters will appear. For example, type \texttt{sin 'tab'}. This trick also works for variable names.

Try typing these in and think about what you would expect the function to do. Here are a bunch of useful functions:

Properties of variables
\[
\begin{align*}
\text{\texttt{length(a)}} & \quad \text{\%gives you the length of the longest dimension} \\
\text{\texttt{size(a)}} & \quad \text{\%gives you the length of all the %dimensions of} \\
& \quad \text{\%the array back as a n-element array) } \\
\text{\texttt{length(a(:,1))}} & \quad \text{\%gives you the length of the column} \\
\text{\texttt{n=1}} \\
\text{\texttt{size(a,n)}} & \quad \text{\%gives you the length of the nth dimension of a} \\
\text{\texttt{length(a(1,:))}} & \quad \text{\%gives you the length of the row} \\
\text{\texttt{a(end)}} & \quad \text{\%gives you the last element of the array}
\end{align*}
\]

Analyzing arrays
\[
\begin{align*}
\text{\texttt{max(a)}} & \quad \text{\%gives the maximum number in each column} \\
\text{\texttt{max(max(a))}} & \quad \text{\%gives the maximum number in whole array} \\
\text{\texttt{a(:)}} & \quad \text{\%linearize an array – in other words make the whole array into one long column}
\end{align*}
\]
>> max(a(:))  %gives the maximum number in whole array
>> min(a)     %gives the minimum number in each column

Rounding numbers
>> a=1.5
>> floor(a)  %rounds down to the nearest integer
>> ceil(a)   %rounds up to the nearest integer
>> round(a)  %rounds to the closest integer

These commands work on whole arrays, too!
>> a=[1:1.1:10]
>> floor(a)  %rounds down to the nearest integer
>> ceil(a)   %rounds up to the nearest integer
>> round(a)  %rounds to the closest integer

Making arrays
>> n=2
>> m=3
>> a=eye(n)  %makes an array of dimension n where all values are zero except on the diagonal where they are equal to 1. It’s the “eye”dentity matrix.
>> a=eye(m,n) %same as above except the array is m by n and starts from the first row first column
>> a=zeros(m,n) %makes an array of zeros m by n
>> a=ones(m,n) %makes an array of ones m by n

3.6 Basic Command Reference Card

- Some basic syntax
  o Defining a variable: \( x = 2 \)
  o Defining a vector \([1 \ 3 \ 5]\): \( y = [1 \ 3 \ 5] \)
  o Defining a matrix \([1 \ 2; \ 3 \ 4]\): \( z = [1 \ 2; \ 3 \ 4] \)
  o Suppressing output: ;
  o Accessing an element in a vector: \( y(2) \) (equals 3)
  o Accessing an element in a matrix: \( z(2, \ 1) \) (equals 3)
  o Accessing a row/column in a matrix: \( z(2, \ :) \) (equals \([3 \ 4]\))
  o Accessing elements in a vector that satisfy some condition \( y(y>2) \) (equals \([3 \ 5]\))
  o Accessing indices of elements in a vector that satisfy some condition \( \text{find}(y>2) \) (equals \([2 \ 3]\))
Transposing a vector: \[ y' \] (equals \[ \begin{bmatrix} 1 \\ 3 \\ 5 \end{bmatrix} \])

Mathematical operators: +, -, *, /, ^

Element-wise operations: .+, .-, .* , ./, .^  
Note the dot!
\[ [1 \ 2 \ 3].*y = [1 \ 6 \ 15] \]

Special numbers (\( \pi, \infty \)): pi, Inf, i

Exponential (e\(^x\)): exp(x)

Natural logarithm (ln x): log(x)

Log base 10, base 2: log10(x), log2(x)

Trigonometric functions: cos(x), sin(x), tan(x)

Absolute value (|x|): abs(x)

Some basic commands

Ways to make vectors:
- Equally spaced intervals: \[ x = 1:0.5:3 \]  
  (equals \[ [1 \ 1.5 \ 2 \ 2.5 \ 3] \])
- All zeros: \[ x = zeros(1, n) \]  
  (equals n zeros)
- All ones: \[ x = ones(1, n) \]  
  (equals n ones)

Draw \( n \) uniformly distributed random numbers between 0 and 1  
rand(1, n)

Minimum of vector \( \text{min}(y) \)

Maximum of vector \( \text{max}(y) \)

Sum of vector \( \text{sum}(y) \)

Mean of vector \( \text{mean}(y) \)

Variance of vector \( \text{var}(y) \)

Standard deviation of vector \( \text{std}(y) \)

Size of vector \( \text{size}(y) \)

Length of vector \( \text{length}(y) \)

4 Plotting

4.1 Basic Plotting

MATLAB has powerful tools for plotting and visualizing data. In this example, we will plot a sine wave in a separate figure.

Let's first define the sine wave:

\[
\text{t}=0:0.1:9 \\
\text{t}=t*\text{pi}/9*4
\]
>> g\uparrow (up arrow key) [This will work if you did the Built-In MATLAB Function section; otherwise type the line below]

The up arrow key fills in the last command line starting with the letter g (very useful). If you leave off the 'g', using the up arrow will scroll through the command history.

>> g=sin(t)

>> plot(t, g);
Here we are plotting the values of $g$ (y-axis) versus the values of $t$ (x-axis).

**Your version of MATLAB may show something slightly different.**

It is probably worth examining the different options for several minutes. Check out the menu options.

To edit the properties of the figure, choose the arrow tool and then double click in the white space of the graph (see below).

![Graph](image)

The Property Editor will appear:
The three circled areas in the window that will appear are very useful. The tabs let you change features of each axis. The scale and label are also circled. To change what the line looks like, click on it. The Property Editor will now show properties of the line, and you can change things such as the line thickness.

```matlab
>> c = sin(t*pi/9*2);
>> plot(t, c);
```

This replaces the first plot. If you had closed the plot, a new plot would have opened. If there are multiple plots open, this command would plot on the figure that you most recently viewed (not the most recently opened!)

```matlab
>> hold on
```
This will overlay any subsequent plots onto the same axes without erasing existing plots.

```matlab
>> up
```
keep pressing up arrow until

```matlab
plot(t, b)
```
appears on the command line

Now use the left arrow key to move the cursor and change the line to read:

```matlab
>> plot(t, g, 'bx');
```

To see what this does, read the MATLAB help on plot by typing `help plot`.

Making your plot easier for others to understand

```matlab
>> legend('value of function');
>> xlabel('x axis');
>> ylabel('y axis');
>> title('my plot');
```
4.2 2D Plotting

>> a=0:9;
>> a=a'*a
>> plot(a);

This plotted each column versus their index numbers (i.e. 1:10) as a different line.

Pseudo 3D Plots

Now try:
>> figure; imshow(a,[]);

You will probably need to increase the size of the figure window to easily see what happened. What is the second argument “[]” needed for? What happens when you omit it?

In the last line of input above, we've demonstrated one other feature of MATLAB – several commands can be entered on a single line, separated by semi-colons.

>> figure; imagesc(a);
>> figure; imshow(a);

We will discuss these commands further in the image processing section.

More 3D Plotting

>> figure
>> mesh(a);

The 'figure' command opens up a new figure window instead of overwriting the current figure window. Compare the values in the array to the 2D plot. The mesh command plots the matrix as a 2D surface. The height of each element is given by the value of the array.

>> a(10,3)=41;
>> a(8,10)=141;
>> figure, mesh(a);

How did this mesh change?

>> b=[0 1 2 3 4 5 6 7 8 100]
>> c=b
>> c(10)=20
>> mesh(b,c,a);

>> figure; surf(a);

What's the difference?
4.3 Exercise 2: Yeast Showdown I
See packet “Yeast Showdown I.”

4.4 Plotting Command Reference Card

- `plot(y)`
  - plot y as the y-axis, with 1, 2, 3, ... as the x-axis
- `plot(x,y)`
  - plot y versus x (must have same length)
- `plot(x,A)`
  - plot columns of A versus x (must have same # rows)
- `axis equal`
  - force the x- and y-axes of the plot to be scaled equally
- `title('A Title')`
  - add a title at the top of the plot
- `xlabel('Description of x axis')`
  - label the x-axis
- `ylabel('Description of y axis')`
  - label the y-axis
- `legend('Series1','Series2')`
  - label the two curves in the plot
- `grid`
  - include a grid in the plot
- `figure`
  - open up a new figure window
- `xlim([x1 x2])`
  - set the x-axis limits to [x1 x2]
- `ylim([y1 y2])`
  - set the y-axis limits to [y1 y2]

To copy figures in MATLAB, go to Edit → Copy Figure. (Ctrl-C won't work.)

5 Writing Scripts and Functions

Sometimes you will want to execute some group of commands repetitively. Instead of typing them over and over again, you can create a script or a function. Both are created in the MATLAB editor, which is a simple text editor.

5.1 Scripts

Scripts are simply a collection of commands, saved in a file (an M-file). Scripts are a good way to write a bunch of commands that you will use over and over again but might want to modify slightly.

To create a new file, go to File → New → M-file
A new window will appear. You can write commands into this window.

```
a=2+4;
b=6;
c=a*b
```

To save this script go to File → Save As... Save your file on the desktop as “First.m”

One important note about writing scripts and functions: where you save the M-file matters! MATLAB only looks in certain folders to find M-files. So once you have saved your file, you must make sure its folder is included in the MATLAB path. To do this, go
to MATLAB window and go to File → Set Path… and then click on “Add Folder…” Find the folder where your M-file is saved, click “Ok” and then click “Close.” When MATLAB asks you if you want to save the current path for future sessions, you can click “Close.” You must do this each time you save a function in a new folder. Your current working folder is automatically included in the MATLAB path, so you can always run an M-file if you first navigate MATLAB to the folder containing the M-file.

There are now two ways to run the script. You can click on the run button (circled below):

![Run button](image)

Or you can call the M-file by its name:

```matlab
>> First
```

This command is case-sensitive—it must be exactly the same as the file name. It is also a bad idea to give the script the same name as a variable or built-in function. To check if a built-in function exists with the name you would like to use, you can type `which <name> -all`. For example, if you name your script `mean.m`, it will run instead of the built-in `mean` function.

In either case, the program runs all three commands one after the other. Go back to the “First.m” window and change the 6 to a `100`

```matlab
>> F↓
```

**Adding comments**

A good way to make your programs more readable is to add comments. This helps other people to make sense of your code; but equally importantly it allows you to figure out what you did when you look at the code in the future. Sometimes you may want to temporarily omit a line of code in your script. Instead of deleting the line of code, you can just tell MATLAB to ignore the line of code. To mark lines in your script that you don't want to run, place a `%` in front of the line. Notice the different color of the line following the `%`. When the program runs, the green lines won't be executed.

```matlab
%This is a comment.
c=3
c+2
%c*c

c =
 3
ans =
```
Here $c+2$ will be evaluated, but $c*c$ will not be evaluated. Note how useful this is for debugging—you can remove a line of code by commenting it out, but easily reverse the commenting if you need it again later. Once you decide for sure that you don’t need the code, you can delete it as usual. You can quickly comment out code by selecting it or putting the cursor on a line and pressing ctrl-r. Ctrl-t “uncomments” the code. (⌘/ and ⌘t on Macs)

Comments can also be entered in blocks:

```matlab
{%
These lines will be Commented out.
%
}
```

This will comment out all lines between the first and last lines of the above input.

### 5.2 Functions

Scripts are great for reusing code that needs to be executed in several locations, but what if you want to create a piece of code that acts on something different each time? For example, when we type \( \sin(2\pi) \), or \( \sin(3/2\pi) \), the \( \sin \) function acts on the angle in parentheses each time and returns a different answer depending on the angle we give it.

MATLAB allows you to extend this concept of a function beyond simple mathematics. We can do this by writing a function. A function is an M-file that will take some input and return some output (or perform some operation). The input is called the argument of a function (2*\( \pi \) or 3/2*\( \pi \) in the example above).

Let's create a function to subtract two numbers (similar to the “-” function).

```
function val=myfunction(a,b)
val=a-b;
end
```

Save this as myfunction.m (on the desktop).

Functions are created by writing a set of commands in the editor and saving the file as an M-file just as in a script, but the first line of the M-file for a function is special. You MUST save the function as an M-file with the same name as the function. The name of the function is the thing that follows the equal sign on the first line of the M-file. Capitalization matters as usual in MATLAB.
As we mentioned above, the first line of a function M-file is special. We first type “function” to let MATLAB know this M-file is a function. We then type \texttt{val=myfunction(a,b)}.

Here \texttt{val} is the return variable – this is the output of the function. \texttt{myfunction} is the name of the function and \texttt{a} and \texttt{b} are the function arguments. This will become more clear as we use the new function.

In the command window type:

\begin{verbatim}
>> result=myfunction(1,2);
>> result
\end{verbatim}

\begin{verbatim}
result =
   -1
\end{verbatim}

How did this work? Remember how to read a line of code:

- Find the equals sign.
- Calculate everything to the right of the equals sign.
- Store the result in the entry to the left of the equals sign.

When MATLAB hits \texttt{myfunction}, it does the following:

1. Is there a variable named \texttt{myfunction}?
2. Is there a file in the current directory (or any other directory in the path) called \texttt{myfunction}?
3. Is there a built-in function called \texttt{myfunction}?
4. Gives an error if no match is found.

In this case MATLAB will determine that \texttt{myfunction} is a user-written function and will pass it two arguments: 1 and 2.

Now \texttt{myfunction} takes 1 and stores it in \texttt{a}, and then takes 2 and stores it in \texttt{b}. So \texttt{a}=1 and \texttt{b}=2. This is because we wrote \texttt{myfunction(a,b)} on the first line of
myfunction.m. The order of the arguments determines which value gets passed to which variable.

It then executes all the lines in myfunction, so \texttt{val} = -1.

Finally it returns the value of the variable \texttt{val}. This is because we wrote \texttt{val=} on the first line of myfunction.m. Therefore, \texttt{return} will be set to 3.

Now try

\begin{verbatim}
>> result=myfunction(2,1);
>> result

result =

1
\end{verbatim}

This time myfunction takes 2 and stores it in \texttt{a}, and then takes 1 and stores it in \texttt{b}. You can also pass variables to the function:

\begin{verbatim}
>> x=2;
>> y=1;
>> result=myfunction(x,y);
>> result

result =

1
\end{verbatim}

\textbf{Quick Exercise:}
Type in:
\begin{verbatim}
>> result=myfunction(myfunction(x,y),y);
\end{verbatim}
What will this return?

\subsection{5.3 Scope}
Here is a function stored as \texttt{myfunction}:

\begin{verbatim}
function val=myfunction(a,b)
   a=a-b;
   val=a;
end
\end{verbatim}

What will we get if we type:
1.
a=2
b=1
val=myfunction(a,b)

2.
a=2
b=1
val=myfunction(a,b)
val=myfunction(a,b)

Is val the same or different the second time we call it? Why?

Now clear a and b. Put a stop sign (breakpoint) after the 2nd line of myfunction.

```matlab
>> x=2;
>> y=1;
>> result=myfunction(x,y);
```

When the program pauses, display the value of x. What happened? Why?

Now step to the the last line of the function and type the following:
```matlab
>> a
>> b
>> x
>> y
```

Now step one more time until you are out of the function, and type the same:
```matlab
>> a
>> b
>> x
>> y
```

Note that the variables a and b are “local” variables to myfunction. That is, they are born and die in myfunction. See this for yourself by trying to access a:
```matlab
>> a
```

?? Undefined function or variable 'a'.

On the flip side, you cannot access any variables in a function that have not been created in or passed to the function. For this reason, when you use a variable in a function, you don’t have to worry about whether you have used it before. The function only knows about the variables that are passed to it or created in it.
5.4 Exercise 3

1. Write a function that takes a 4-number row vector and returns it as a 2 by 2 array.
2. Make a function that takes two 4-number row vectors converts them into 2 by 2 arrays (sounds like question 1 doesn't it?) and then performs matrix multiplication on the resulting arrays.

See the second part of *Yeast Showdown I* for further practice on functions.
5.5 Loops and Flow Control

In both scripts and functions, you may want to perform repetitive tasks. Loops can be used to perform repetitive tasks within a program. There are also various “flow control” devices that are useful for structuring programs.

5.5.1 For Loop

In MATLAB, there are two types of loops, “for” loops and “while” loops. In most cases, a given task can be written in either format, but one is often more convenient than the other. We will start with the “for” loop, which has three components, the loop statement, the loop body, and the end statement.

Make an M-file

```matlab
a = [0 52 25 231]
for i = a
    i
end
```

Save as loops.m (on the desktop).

```matlab
>> loops
```

In this case, the loop statement indicates that the loop variable `i` will be set, one-by-one with each loop iteration (run-through), to the next value in `a`. The loop body is located between the loop statement and end statement and is executed once per loop iteration. This loop will iterate four times, one for each value of `a`, printing out the current value of `i` at each iteration.

Now that our programs are getting more complicated, it is time to become familiar with the debug function, which can help you figure out what is wrong when your code is not executing as expected.

To use the debugger, after saving the M-file, click on the line just to the left of the text in the code. This should create a stop sign. When you run the program now it will stop at this stop sign. You can now step through the program line by line or run it until the next stop sign, by using the buttons in the text editor tool bar (to see what each does, mouse over the buttons). When the program is stopped you can check the values of all your variables (by mousing over the variable in the code) and even perform operations in the command window. This is not only very useful for debugging but also for learning.

For loop examples

Make an M-file

```matlab
for x = 1:10
    x*x
end
```
In this example, the loop statement is a bit different. The loop runs through the loop body, starting \( x = 1 \) for the first iteration and incrementing \( x \) by one until \( x \) is equal to 10.

\[
\text{>> } \text{loops2}
\]

In these examples, there is only one line of code in the loop body; however, there is no limit on the number of lines that can appear in the loop body.

Make an M-file
\[
a=\text{zeros}(10,1);
\]

\[
\text{for } x=1:\text{length}(a)
\quad a(x)=x^2;
\quad \text{end}
\]

\[
a
\]

Save as loops3.m

\[
\text{>> } \text{loops3}
\]

The construction of the loop statement above is a very useful one. It lets you run through the values of a variable (in this case \( a \)), using the loop variable (\( x \)) as the index (\( a(x) \)).

Make an M-file
\[
y=10;
\quad a=[];
\quad \text{for } x=1:y
\quad \quad a(\text{end}+1)=[x^2]
\quad \text{end}
\]

\[
a
\]

Save as loops4.m

\[
\text{>> } \text{loops4}
\]

\[
a=[]; \quad \text{makes an empty array}
a(\text{end}+1) \quad \text{specifies the entry after the last entry in } a. \text{ In a empty vector, this is } a(1).\text{ In a 1x1 vector, this is } a(2), \text{ and so on.}
\]

Make an M-file
\[
a=\text{[0 1; 52 2; 25 1; 231 3]}
\quad \text{for } i=a
\]
The example above shows that you can loop through a multidimensional array as well as a vector (1d array).

To make the code easier to read, MATLAB's editor automatically indents the loop body. The indentation doesn't affect the code's functioning, but it is useful for understanding code and helping you to visualize its structure. If your indentation gets messed up, you can have MATLAB indent it correctly by selecting the lines of code you want fixed and typing Ctrl-I (or going to Text → Smart Indent).

5.5.2 If Statement and Logical Operators

The 'if' statement can be used to control the flow of the program and execute a certain set of instructions only if certain criteria are met. Below we demonstrate its use, along with a set of logical operators, operators that check whether certain statements are true.

The logical operator we use in the first example is "==", the “is equal” operator. If you write the statement \( a == b \), it returns “true” if \( a \) and \( b \) are equal and “false” otherwise. Below we use this operator with the if statement. The “==” is different that the “==”!

The statement \( a = b \) simply sets the variable \( a \) equal to the variable \( b \).

We use the mod (modulus) function below. It takes the form \( \text{mod(numerator, denominator)} \) and returns the remainder of numerator/denominator. Type help mod for more information.

Make an M-file:

\[
a=1:100; 
\]
\[
b=[]; 
\]
\[
\text{for } x=1:100 
\]
\[
\quad \text{if } (\text{mod}(a(x),10)==3) \quad \% \text{if statement} 
\]
\[
\quad b(\text{end+1})=a(x); \quad \% \text{statement body} 
\]
\[
\quad \text{end} \quad \% \text{end statement} 
\]
\[
\text{end} 
\]
\[
b 
\]

Save as loops5.m

In this first “for if” loop, we check each element of \( a \) to see whether the remainder when divided by 10 is equal to 3. If this is true, the element of \( a \) is inserted into \( b \).
>> loops5
The `if` statement checks whether a condition is true. If it is true, it executes the commands in the statement body. The statement body is located between the `if` statement and the `end` statement. Like loop bodies, statement bodies can contain multiple commands.

In this next example we demonstrate more logical operators. The “>” and “<” are the greater than and less than operators, and the “>=“ “<=“ are the greater than or equals to and less than or equals to operators. They are used just like the equals operator – the statement `a > b` evaluates as “true” if `a` is greater than `b`, and false otherwise.

The “||” operator is the “or” operator. If either the statement before the “||” or after the “||” is true, the statement is considered true.

Make an M-file
```
c=[];
for x=1:100
    if ((a(x)>=91) || (a(x)<9))
        c(end+1)=a(x);
    end
end
```

Save as loops6.m

```
>> loops6
```

This example shows two more useful operators. The “~=" operator means “not equal.” The “&&” operator means “and”. The statements before and after the “&&” must be true for the statement to be true. With the proper use of parenthesis, multiple “and” and “or” statements can be used to make complicated logical tests.

Make an M-file
```
d=[];
for x=1:100
    if ((mod(a(x),10)~=1) && (mod(a(x),10)<2))
        d(end+1)=a(x);
    end
end
d
```

Save as loops7.m

```
>> loops7
```
5.5.3 Elif and Else Statements

The "elseif" and "else" statements can be used in conjunction with "if" statements to create more complicated program structures.

Make an M-file

```matlab
a=[];
b=0;
for x=1:100
    if mod(x,10)==1
        a(end+1)=x;
    elseif mod(x,10)==2
        a(end+1)=x+100;
    else
        b=b+1; %executed if (mod(x,10)~=1)&&(mod(x,10)~=2)
    end
end
a
b
```

Save as loops8.m

The 'a(end+1)=x+100' is executed if (mod(x,10)==1) && (mod(x,10)==2).
The 'b=b+1' is executed if (mod(x,10)==1) && (mod(x,10)==2).

>> loops8

5.5.4 While Loop

Like for loops, while loops are contain three parts: the loop statement, the loop body, and the end statement. In each iteration, the while loop checks whether the loop statement is true. If it is, it performs the operations in the loop body and again returns to the loop statement to see if it is true. When the statement is untrue, it proceeds to the next bit of code following the end statement.

Make an M-file:

```matlab
x=1;
while (x<100) %loop statement
    x=x*1.3 %loop body
end %end statement
```

Save as loops9.m

>> loops9

It is easy to make “infinite” while loops – loops that never end. To avoid this, you need to make sure that the “while” statement becomes false at some point. If you
5.6 Random Number Generator

Often times, you will need to generate random numbers, e.g. if you want to simulate a stochastic process. The `rand` command creates a random number between 0 and 1. The `rand(m,n)` command generates an m by n array with random numbers. To learn more, type `help rand`. The `randn` command creates a random number normally distributed around 0 with standard deviation of 1. (Type `help rand` for more!)

```matlab
>> A=rand(20,1);
>> A=A*100       %gives random numbers between 0 and 100
>> hist(A)       %creates a histogram of A
```

5.7 Break and Continue Commands

`Break` statements are a good way to get out of while loops if some set of conditions has been satisfied.

Make an M-file

```matlab
y=round(rand(1,100));
x=0;
for i=1:length(y)
    if (y(i)==1)
        x=x+1;
    else
        break;
    end
end
```

Save as loops10.m

```matlab
>> loops10
```

If you don't want to quit the loop entirely, but instead just want to skip to the next iteration (run-through) of the loop, use the `continue` command.

Replace 'break' with 'continue', save the file and run it again to compare the results. What does `x` represent in each version of loops10.m?

As we show above, you can nest MATLAB commands, e.g. `round(rand(1,100))`. This takes the output of `rand(1,100)`, a vector with 100 random numbers, and passes it to `round`. To learn more about MATLAB rounding functions type `help round`, `help floor`, and `help ceil`. 

40
5.8 Exercise 4

1. Make a program that randomly picks a number between 1 and 100. If the value is between 1-10 have the program output the number. If the value is between 20-30 have the program output the number plus 100. Otherwise output the value minus 100.

2. Make a program that randomly picks a number between 1 and 100. Use a while loop to find the closest integer less than the random number. Break out of the loop and print the value (should be equivalent to rounding down).

3. In MATLAB, loops are sometimes necessary, but if possible, code runs faster when loops are replaced by vector operations. Can you re-write the loops in this section in vector form?

5.9 Flow Control Command Reference Card

Logical operators

==  equal
~==  not equal
>  greater than
<  less than
>=  greater than or equal to
<=  less than or equal to
||  or
&&  and
xor  exclusive or (returns true if EXACTLY one of the two statements is true)

Loop control statements

for  to start a for loop, e.g. for i=1:10
while  to start a while loop, e.g. while (x<10)
end  to enclose a loop body
break  exits the loop
continue  moves to the next loop iteration

We also learned how to use if, elseif, and else statements in this section.
6 Other Data Types
(when you are not just dealing with numbers)

Often we are not dealing with just numbers. For example we might have microarray data where numbers are associated with lists of genes that we also need to track. Alternatively, we may be taking hundreds of images. We might need to keep track of filter set or exposure time in order to properly compare images. In short, arrays are limited for two reasons: (1) there is no way to store text; (2) it is difficult to associate text with array positions (array positions are numbers). There are some good ways of dealing with these problems in MATLAB (and in other programming languages).

>> clear;
%This command is useful if you have built up a whole bunch of items in the workspace and want to start over. But use with caution - it erases the values of all the variables in the workspace

>> [num,txt]=xlsread('MicroArrayData.xls');

(You should also take a look at the csvread command.)

If you look at num in the workspace it is an array of numbers (doubles). txt is something different. It is a cell array. This is denoted in the workspace pane by the fact that the icon is {} not the small spreadsheet icon of an array.

Double click txt in the workspace so you can look at the array. It is an array of text!
Individual characters of text (like the letter “a” or “C”) are referred to as type char (or character). A bunch of char in a row or an array of char is called a string.

6.1 Getting Friendly with Strings

>> String1='My First String';

A new variable has appeared. It also has a new icon in the workspace (this icon means char).

>> whos String1
whos is a useful command that gives you information about a variable. String1 is a 1 by 15 array of characters.

Strings are not so different from numerical arrays. Try to guess the output of each of these commands before typing them in.

>> String1(1:2:end)
>> String1(4:9)
When entering text, you must put it inside single quotes. This is so MATLAB knows you are entering text, not code (i.e. variable and function names).

Because they are arrays, strings can be concatenated as other arrays are:

```matlab
>> String2=[String1,' and My Second String'];
```

### 6.2 Interconverting Strings and Numbers

Each character is associated with a specific number (ASCII for those of you who know what this means). Therefore, you can convert between numbers and strings:

```matlab
>> double(String1(4:9))
>> char([65 99 101])
```

You may have noticed that the data type of characters is `char`, and the data type of numbers is `double`. Why `double`, you ask? `double` is short for “double precision,” as opposed to “single precision.” A single precision number takes less memory to store, but has a smaller range and precision than a double precision number. The default data type for numbers in MATLAB (and many other programming languages) is double.

Converting between strings and numbers in this way isn’t incredibly useful, so let’s look at a more useful example.

Let’s say you had a variable:

```matlab
>> ImageNumber=10;
```

This number might be useful in the title of a figure.

```matlab
>> figure,peaks(31)
>> title(['Image Number ',ImageNumber])
```

This won’t work correctly because `ImageNumber` is a double, not a string, and you cannot concatenate different types of data together in this way.

```matlab
>> title(['Image Number ',num2str(ImageNumber)])
```

The `num2str` command is the command that will convert a number into the corresponding text character.

Note the difference between:

```matlab
>> num2str(1)
```

and

```matlab
>> char(1)
```

There are a bunch of useful functions that can be used with strings. I recommend reading about `strfind` and `strcmp` (and `regexp` if you already can guess what that function will do).
6.3 Structures and Cell Arrays

We started our packet with basic data structures – scalar variables (e.g. \( x = 2 \)) and arrays. As problems get more complicated, arrays and scalars may not be sufficient for your needs. For example, for a particular data point, you may want to store a variety of pieces of data in a more unified way. The choice of a good data structure can simplify one's “algorithmic life.” We will review two more data structures below.

Structures

A structure is a MATLAB array that divides its contents up into fields. The fields of a structure can contain data types different from one another, and this is the main reason for their use. A few examples will illustrate how they are defined and used.

\[
\begin{align*}
S.name &= \text{'Jason Knapp'}; \\
S.age &= 22; \\
S.egr_335_grade &= \text{'A'}; \\
S.grade &= \text{'senior'};
\end{align*}
\]

Here, our structure is \( S \), and the fields are \( \text{name, age, egr\_335\_grade, and grade.} \)

Now that we have defined a structure, we need to know how to access the information contained within its fields. This structure contains multiple types of data: strings and a number. This would not have been possible with a single array. Furthermore, instead of having to remember what column the name or age was stored in as one would in an array, we can now refer to the name, age, etc. in a much more natural way.

\[
\begin{align*}
\text{fieldnames}(S)
\end{align*}
\]

This lists all the fields associate with a structure. To access the values of a field we use the . operator:

\[
\begin{align*}
S.name \\
\text{ans =} \\
\text{Jason Knapp} \\
\text{z = S.age*2} \\
z = 44
\end{align*}
\]

To reiterate: structures can contain data of any type, arrays, strings, other structures, and cell arrays. A useful function when creating structures in MATLAB is the \textit{struct} command. Type \texttt{help struct} to learn more about it and several other commands that can be used with structures.

To add another name:

\[
\begin{align*}
S(2).name &= \text{'John Smith'};
\end{align*}
\]

What happened?

\[
\begin{align*}
S
\end{align*}
\]
A second entry in the structure was made, in which every field is defined (though they are mainly empty).

```matlab
>> S(2).age='Unknown';
```

```matlab
>> S.age
```

Now we have different types of data under the "age" field.

```matlab
>> S(2).NewField=[3,4;12,4];
```

```matlab
>> S(1)
>> S(2)
```

When a structure has a single entry, assignments like `S.name` are shorthand for `S(1).name`. However, when your structure has multiple entries, this shorthand no longer works.

Addressing entries in structures is just like accessing elements in array – things like `S(end)` and `S(1:3)` are perfectly legal. These can be combined with field specifications, e.g. `S(1:2).name`. In general, many of the commands available for arrays, e.g. `size`, `length`, have analogs for structures.

The figures below, taken from the MATLAB documentation, illustrates the structure `S`, with fields `a`, `b`, and `c` with one and two entries.
Cell arrays

**Cell** arrays are MATLAB arrays of containers. Each container can hold data of any type, but unlike structures that store their data in fields, **cell** arrays store their data as actual elements. An example will illustrate their use.

```matlab
>> a{1, 1} = ones(3,1);
>> a{2, 1} = 'This is second row and first columns';
>> a{2, 2} = randn(3) ;
>> a{1, 2} = 'row 2 column 2 is a 3x3 random matrix';
```

The figure below, taken from the MATLAB documentation, shows a 2 x 3 cell array containing numerical arrays, text arrays, and a nested cell array (cell 2,3).

With **cell** arrays, when assigning elements use the curly brackets instead of parentheses. Here is how to access the elements of a **cell** array:

```matlab
>> tmp=a{1, 1};
>> tmp2=a(1, 1);
```

Let's look at the difference in the classes:

```matlab
>> whos tmp2
>> whos tmp
```

The {} returns what's in that cell.
The () returns the cell itself.
\begin{verbatim}
>> subcell = a(1:2,2)  \%Note the use of( ) instead of { }

    subcell =
    'row 2 column 2 is a 3x3 random matrix'
    [3x3 double]

>> X = 3*a{2,2}

    X =
     0.5239
    -1.7649
     0.3418
    -0.5601
     6.5496
     3.2003
     2.1774
    -0.4092
     0.1778

>> a{1,2}

    ans =
    row 2 column 2 is a 3x3 random matrix

Now that we have learned about both cells and structures, we can use them together.
Try:
>> f = fieldnames(S)
>> whos f

Note that \texttt{f} is a cell array of the field names in the structure \texttt{S}. (This allows for the fact that field names are different lengths!)

Now, if we want to inspect the values of the structure, by field name we can use this loop:

\begin{verbatim}
>> for CurrentField=f'
    >> S.(cell2mat(CurrentField))
    >> end
\end{verbatim}

We enclose \texttt{(cell2mat(CurrentField))} in parentheses so that MATLAB knows that it must evaluate this expression to get the field name. The general format is \texttt{StructureName.(VariableFieldName)}. We use the \texttt{cell2mat} command to convert the cell container into a matrix since a field name can't be type \texttt{cell}; it must be type \texttt{char}.
\end{verbatim}
6.4 Parsing data and text in figures
Let's return to our microarray data.

When we loaded it, we got two arrays: **num**, an array of doubles and **txt**, an array of cells.

If we look at **txt** we can see there is actually a header of three cells and then the info we want in the rest of column 1.

This will happen often. You will get data in one format and then need to extract it into some other useful format. This process is referred to as parsing and can take a significant amount of time to get right. It is often useful to write a program to automatically do the parsing for you.

Here is an example of a function that will parse this data.

```matlab
function [ S ] = ParseXLSArrayData( num,txt )
%ParseXLSArrayData converts imported array data into a useful structure
% Creates a structure S
%This structure has three fields
%The first field is the element in the header of the first text column.
%The second field is the rest of the header and is called header.
%The third field is called data and is an array of the microarray data.

S.header=txt(1,[2,3]);
S.(txt{1,1})=txt(2:end,1);
S.data=num;
end
```

```matlab
>> S=ParseXLSArrayData(num,txt);
```

And here is a function that makes a nice figure. Take some time to study and try to understand this and the last function. It combines together a number of the concepts we’ve covered in this packet.

```matlab
function PlotSpeciesComparison( S , cutoff,listnames)
%PlotSpeciesComparison
%Plots the species data in the first two column of data versus each other.
%Adds names to the plots based on the cutoff of required difference between
%the values.
%If listnames is not 0 list names on plot

figure,plot(S.data(:,1),S.data(:,2),'.','Color',0.75*[1 1 1])
%The array following color is the amount of [red green blue] in the color
```
% The numbers can be between 0 and 1. All 0 is black. All 1 is white.
hold on
SignificantORFs = abs(S.data(:,1) - S.data(:,2)) > cutoff;
% In this case the array data is assumed to be in log scale already
plot(S.data(SignificantORFs,1), S.data(SignificantORFs,2), '.', 'Color', 0.25*[1 1 1])
if listnames ~= 0

text(S.data(SignificantORFs,1), S.data(SignificantORFs,2), S.ORF(SignificantORFs))
    xlabel(S.header(1));
    ylabel(S.header(2));
end
end

>> PlotSpeciesComparison(S, 3, 0)

>> PlotSpeciesComparison(S, 3, 1)

Special Thanks
Zeba Wunderlich
Kueh Hao

Last updated 8/17/11 by JW.